Campus 2.0
Instructor Guide
For PC and Mac Users

July 13, 2009
IMPORTANT NOTICE

© Copyright 2009 Tegrity™, Inc.
DISCLAIMER

© 2009 Tegrity, Inc. all rights reserved
# TABLE OF CONTENTS

About This Guide ....................................................................................................................... 1

Chapter 1. Introduction .............................................................................................................. 2
  What is Tegrity? ......................................................................................................................... 2
  Tegrity Instructor Workflow ..................................................................................................... 2
  Tegrity Online Help .................................................................................................................. 2

Chapter 2. Accessing Tegrity Campus ..................................................................................... 4
  Quick Links ............................................................................................................................... 7
  Menu Bar ................................................................................................................................. 8
  Toolbar Buttons ....................................................................................................................... 9
  Navigation Buttons ................................................................................................................ 9

Chapter 3. Recording a Class .................................................................................................... 10
  Starting Tegrity Recorder ....................................................................................................... 10
  Recording with Tegrity Recorder .......................................................................................... 12
    Entering the Instructor’s Name ............................................................................................ 12
    Selecting the Name of your Course ...................................................................................... 12
    Naming the Class Recording ................................................................................................. 13
    Adjusting the Recording Audio Level .................................................................................. 13
  Recording Classes ................................................................................................................ 14
  Tegrity Recorder Instructions for Mac Users ......................................................................... 16
    Installing the Tegrity Recorder Application on Your Mac ................................................ 16
    Updating the Tegrity Recorder Application on Your Mac .................................................. 19
    Recording Classes on Your Mac .......................................................................................... 19
  Uploading an Audio File as a Class ....................................................................................... 22
  Presenting Classes in Real Time with Tegrity Live ............................................................... 23
  Scheduling Live Classes ....................................................................................................... 23
Table of Contents

Chapter 4. Using the Advanced Recording Features .............................................................. 30
  Adding Annotations during a Class Recording ................................................................. 30
  Using the Tegrity Instructor Pen ....................................................................................... 32
    Installing Batteries in the Tegrity Pen Reader ............................................................... 32
    Installing Batteries in the Tegrity Instructor Pen .......................................................... 33
    Replacing the Ink Cartridge in the Tegrity Instructor Pen ............................................ 33
    Preparations for Recording with the Tegrity Instructor Pen ....................................... 34
    Using the Tegrity Instructor Pen During Class .............................................................. 34
  Capturing Video from a Video Source .............................................................................. 36

Chapter 5. Configuring Course Settings .............................................................................. 38
  Viewing and Modifying Course Settings ......................................................................... 39
  Selecting Recording Options ......................................................................................... 40
  Selecting a Publishing Option ........................................................................................ 40
  Selecting Delivery Options ............................................................................................. 42
  Assigning an iTunes U Tab for a Course ......................................................................... 43
  Restoring Default Settings ............................................................................................. 43

Chapter 6. Configuring the Tegrity Recorder ..................................................................... 44
  Selecting a Picture ............................................................................................................ 44
  Using Instructor Video in the Class Recording .............................................................. 45
  Configuring Recorder Audio and Video Settings .......................................................... 46
    Selecting the Audio Source .......................................................................................... 47
    Selecting the Video Settings ......................................................................................... 48
    Selecting a Different Audio Source for Different Video Sources .............................. 48
    Testing Your Audio and Video Capabilities ................................................................ 49
    Enabling Multimedia Room Mode .............................................................................. 51
  Managing Your Course Uploads ..................................................................................... 51

Chapter 7. Accessing Recordings and Additional Content ............................................... 53
  Viewing the Class Recordings for a Course ..................................................................... 53
    Navigating through your Class Recordings List ........................................................... 54
  Viewing a Class Recording Online .................................................................................. 54
  Searching Class Recordings ............................................................................................ 59
    Searching for Specific Content in All Class Recordings ............................................ 59
Chapter 8. Managing Class Recordings and Additional Content ............................................. 67
  Selecting a Class from the Course Management Page ...................................................... 67
  Copying a Class Recording ................................................................................................. 68
  Moving a Class Recording .................................................................................................. 69
  Deleting a Class Recording ................................................................................................. 69
  Renaming a Class Recording ............................................................................................... 69
  Editing a Class Recording ................................................................................................. 70
  Cutting Segments from a Class Recording ........................................................................ 70
  Adding Closed Captions to a Class Recording .................................................................. 71
  Editing Chapter Information .............................................................................................. 72
  Adding Video to a Recording .............................................................................................. 73
  Adding a Searchable Keyword ........................................................................................... 74
  Manually Controlling Publication of Class Recordings ...................................................... 75
  Manually Publish a Class Recording .................................................................................. 75
  Publishing to iTunes U ........................................................................................................ 76
  Providing Direct Links to Class Recordings ..................................................................... 77
  Posting a Class Recording to the Tegrity Community ..................................................... 78
  Creating Additional Content ............................................................................................. 79
  Uploading Files .................................................................................................................. 79
  Adding External Links ....................................................................................................... 80
  Deleting Additional Content ............................................................................................. 81
  Creating a CD or DVD of Class Recordings ..................................................................... 82

Chapter 9. Creating Bookmarks in a Recording ................................................................. 84
  Creating Bookmarks while Recording a Class .................................................................. 85
  Creating Bookmarks Using Your Computer ..................................................................... 85
  Creating Bookmarks Using your Mobile Phone ............................................................... 87
  Creating Bookmarks while Reviewing a Recording ........................................................ 89
# Table of Contents

- Activating/Deactivating a Bookmark .......................................................... 90
- Viewing Content Related to a Bookmark ....................................................... 90
- Emailing Bookmarks ..................................................................................... 91
- Deleting Bookmarks ..................................................................................... 92

## Chapter 10. Generating Reports ................................................................. 93
- Creating a Weekly Summary Snapshot .......................................................... 93
- Creating a Detailed Report ............................................................................ 95
- Creating a Custom Analysis Report .............................................................. 96
  - Generating a Student Viewing Report ......................................................... 97
  - Generating a Student Viewing Report by Chapter ..................................... 99
  - Generating a Class Recordings Report ......................................................... 100
- Downloading a Report................................................................................ 101
- Creating an Outcome Analysis Report ......................................................... 101

## Chapter 11. Online Collaboration ............................................................... 103
- Viewing Announcements and News ............................................................. 103
- Accessing Forums ......................................................................................... 105
- Accessing the Community Board .................................................................. 107

## Chapter 12. Contacting Tegrity ................................................................. 108
ABOUT THIS GUIDE

This guide is intended for instructors who want to use Tegrity Campus to record class sessions for subsequent review by their students. Instructors are assumed to be familiar with their institution’s Course Management System and to have experience using personal computers for class presentations.
Introduction

What is Tegrity?

Tegrity is the first Student Achievement System that impacts learning across the entire institution, improving retention and student satisfaction. Tegrity makes class time available on-demand by automatically capturing, storing, and indexing classes for replay by students. With Tegrity, students can quickly recall key segments of classes or replay entire classes online, on iPods, and on cellular telephones.

Tegrity Instructor Workflow

As an instructor, you follow a simple workflow for each course you record on Tegrity:

- Record your classes using the Tegrity Recorder.
- Manage the distribution of class recordings and set your course settings.
- Generate reports.

Tegrity Online Help

As you work with Tegrity, a Help button appears in most of the screens. If you are unsure of the best way to take advantage of a screen’s features, or require further information you can access the following Help options:

- **Online Help** – Displays information that is relevant to the screen in which you are working.
- **Docs & Tutorials** – Provides access to training material and tutorials.
- **Knowledge Base** – Provides access to articles on using Tegrity.
• **Get Support** – Provides contact information of your institution’s Tegrity support personnel.

**To access Help:**

• From the **Help** tab select one of the Help options. The selected Help page appears.

–OR–

1. From the *Quick Links* area located on the *My Tegrity* (Figure 3) and *Class Recordings* (Figure 2) pages, click **Help**. A Help page appears with links to the Help options.

2. Click one of the Help options. The selected Help page appears.
ACCESSING TEGRITY CAMPUS

You can access Tegrity Campus from your Course Management System or directly.

When you access Tegrity Campus from your Course Management System, the first screen that appears is the Class Recordings page. The Class Recordings page displays a list of recordings for your course. You can also access the Tegrity Recorder from this page. The Tegrity Recorder enables you to record your classes.

When you access Tegrity Campus directly, the first screen that appears is the Instructor Course list screen, which lists all of your courses that are enabled for recording.

To access Tegrity Campus from your Course Management System:

- Log into your Course Management System and navigate to the course you would like to access. Click the Tegrity link or button located in your course page, as shown in the following example.
The **Class Recordings** page appears (Figure 2). Class recordings that you have not viewed are bolded.

Figure 1: Course Management System Page with Tegrity Button

Figure 2: Class Recordings Page
• If you are not using a Course Management System, you can log into Tegrity in one of the following ways:

• Right-click the Tegrity Recorder icon in your system tray and select Login to Tegrity Campus.

–OR–

• Open a browser window and type the address of your Tegrity server. You will be prompted for a user ID and password. Contact your Tegrity support personnel if you do not have this information.

The My Tegrity page appears (Figure 3), showing all of your active and archived courses. Archived courses have the word Archive preceding the name of the course. The number of recordings that you have not viewed appears next to each course title.

![My Tegrity Page](image)

Figure 3: My Tegrity Page

**Note:** Your on-campus Tegrity support staff members are responsible for enabling you to use Tegrity Campus. Contact your support staff for assistance with the following problems:

• You do not know the URL for the Tegrity Server.
• You do not know your User ID and password.
• You do not see a Tegrity link or button in your course page in your CMS.
• You do not see your course listed in your My Tegrity page.
The *My Tegrity* page displays the following information:

<table>
<thead>
<tr>
<th>Name</th>
<th>Information Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course</td>
<td>The title of the course followed by the number of class recordings that you have not viewed.</td>
</tr>
<tr>
<td># of Classes</td>
<td>The total number of class recordings available for viewing.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The last date your instructor updated the class recording.</td>
</tr>
</tbody>
</table>

### Quick Links

In addition, the *My Tegrity* page (Figure 3) and the *Class Recordings* page (Figure 2) provide quick links to:

- **User Forums**, which include both Instructor and Student forums (refer to *Accessing Forums* on page 105).
- **Reports**, which include links to Weekly Summary, Detailed Reports, Custom Analysis and Outcome Analysis (refer to *Generating Reports* on page 93).
- **Bookmarks**, which enable you to add bookmarks to a class recording (refer to *Creating Bookmarks in a Recording* on page 84).
- **Help**, which include links to online help, user guides, tutorials, and additional support for using the Tegrity Campus application.
- **Let Tegrity Know!**, which enables you to send a comment to Tegrity support (refer to *Contacting Tegrity* on page 108).
- **Latest Updates** which are links to the last recordings that were uploaded for courses in which you are enrolled.
Menu Bar

The Tegrity menu bar provides access to the following Tegrity features:

Table 2: Menu Bar

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In Class</td>
<td>Enables you to create bookmarks while you are recording a class (refer to Creating Bookmarks while Recording a Class on page 85).</td>
</tr>
<tr>
<td>Community</td>
<td>Provides access to Tegrity Announcements, Instructor Forums, and User Forums (refer to Online Collaboration on page 103).</td>
</tr>
<tr>
<td>Reports</td>
<td>Enables you to create Reports (refer to Generating Reports on page 93).</td>
</tr>
<tr>
<td>Help</td>
<td>Provides access to Online Help, Docs &amp; Tutorials, Knowledge Base, and Support (refer to Tegrity Online Help on page 2).</td>
</tr>
</tbody>
</table>
## Toolbar Buttons

The following toolbar buttons provide access to various Tegrity applications and subscriptions to media update services.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Icon]</td>
<td>Provides access to the Tegrity application for Facebook.</td>
</tr>
<tr>
<td>![Button Icon]</td>
<td>Provides access to the Tegrity application for your iPhone.</td>
</tr>
<tr>
<td>![Button Icon]</td>
<td>Provides access to the Tegrity application from your mobile phone.</td>
</tr>
<tr>
<td>![Button Icon]</td>
<td>Enables you to subscribe to enhanced audio podcasts or video podcasts for your courses (refer to <em>Subscribing to Media Updates</em> on page 63).</td>
</tr>
<tr>
<td>![Button Icon]</td>
<td>Enables you to subscribe to RSS feeds for your courses (refer to <em>Subscribing to Media Updates</em> on page 63).</td>
</tr>
<tr>
<td>![Button Icon]</td>
<td>Enables you to subscribe to MP3 podcasts for your courses (refer to <em>Subscribing to Media Updates</em> on page 63).</td>
</tr>
</tbody>
</table>

## Navigation Buttons

The navigation buttons (◀ and ▶) provide quick access to previously viewed pages. This is especially useful when working with your search results since it enables you to quickly return to your search results after selecting a specific class recording to play (refer to *Searching Class Recordings* on page 59).

**To access the previous page you viewed:**

1. Click ◀. The previous page you viewed appears.
2. Click ▶ to return to the referring page.
**RECORDING A CLASS**

Tegrity enables you to record your class sessions for subsequent review by your students. For each course you teach, you can use Tegrity to:

- Record every class session.
- Record supplemental material.

**Starting Tegrity Recorder**

Tegrity Recorder can be accessed from the *Course Management* page. If you are a Mac user, continue with the topic *Tegrity Recorder Instructions for Mac Users* on page 16.

**Note:** If you are using a computer from which you previously accessed Tegrity Campus, a Tegrity icon appears in your system tray. (The system tray is located at the bottom right corner of your screen.) This icon enables you to easily access the Tegrity Recorder.

To start Tegrity Recorder from your course management system:

1. Log into your Course Management System and navigate to the course you would like to access.
2. Click the **Tegrity** link or button located in your course page. The *Class Recordings* page appears with the **Record a Class** button in the upper left corner of the page (Figure 2).
3. Click **Record a Class**. The *Tegrity Recorder* window appears (Figure 5). If this is the first time you are recording a class, the *Tegrity Recorder* icon is added to your system tray.
To start Tegrity Recorder using the *Tegrity Recorder* icon:

- Double-click the Tegrity icon in your system tray, located at the bottom right corner of your screen.

**Note:** Depending on your institution’s policies and Tegrity settings, you may be prompted to enter your Tegrity user ID and password.

The first time you click **Record a Class** from your computer, there is a delay before the *Tegrity Recorder* window appears while Tegrity prepares to record your class.

The *Tegrity Recorder* window provides information about your class recording, including:

- Your name.
- The course title.
- The title of your class recording.
- The general settings to use during the class recording.

**Note:** Some of these settings are defined by your administrator and do not need to be changed.
Recording with Tegrity Recorder

When Tegrity Recorder opens, it displays an instructor name and a course name. You can change these names as needed.

Entering the Instructor’s Name

The instructor’s name appears in the Hello field of the Tegrity Recorder window. If the name in the Hello field is not correct, you need to change the name.

To change the name in the Hello field:

1. Click Change User. The Tegrity Login dialog box appears.
2. Enter your Tegrity user ID. If you do not know your user ID, contact your Tegrity support personnel.
3. Click Ok. Your user ID is verified and your name appears in the Hello field.

Selecting the Name of your Course

The course name for the class you want to record appears in the Course field.

To change the course name:

- Click the arrow to the right of the Course field and select the correct name of the course from the drop-down list.

Note: If you do not see your course in the drop-down list, make sure that your name appears in the Hello field to ensure you are identified correctly (refer to Entering the Instructor’s Name on page 12.) If your course title does not appear in the list, you may still record by selecting your Private Course from the Course drop-down list. This course is only accessible to you, and has no students enrolled in it. If your course is missing from the course list, contact your Tegrity support staff to have the list updated. Once the missing course is added you can move the recording from your Private Course to the new course. You cannot record to an archived course.
Naming the Class Recording

You can define a recording title for the class, which, by default, is the date and time that the class is recorded (Figure 47).

To change the name of the class recording:

- Select the text in the Title field and type the name of the class recording as you want it to appear.

Adjusting the Recording Audio Level

The recording audio level received from the microphone is displayed on the audio level indicator in the Tegrity Recorder window (Figure 6).

To adjust the recording audio level:

1. Speak into the microphone in a normal voice and note the audio level on the audio level indicator. The audio level should appear in the green-to-yellow area of the audio level indicator.

2. If necessary, use the audio level slider to adjust the audio level.

Note: If the audio level indicator is in the red area, lower the volume. If you record your class when the indicator is in the red area, your voice may sound distorted when playing back the recording.
Recording Classes

Tegrity provides easy-to-use controls for recording your classes. The following additional features are particularly useful for practice sessions or setup:

- Preview a recording before uploading.
- Delete a class recording.

To record your class:

1. Start Tegrity Recorder and click **Record a Class** (refer to *Starting Tegrity Recorder* on page 10). The first time you click **Record a Class**, a dialog box appears displaying information about the Tegrity Recording toolbar icons.

   **Note:** If you have exclusive use of the computer and don’t need instructions for using the toolbar icons, select the **Don’t show this message again** checkbox.

2. Click **OK**. The dialog box closes and the Tegrity Recording toolbar appears at the bottom of your screen.

   ![Figure 7: Tegrity Recording Toolbar](image)

3. As you speak, the volume indicator (■) shows the volume level at which the audio is being recorded. For information about the recommended audio level, refer to *Adjusting the Recording Audio Level* on page 13.

4. During the recording process, use the Tegrity Recording toolbar buttons to pause (■), resume (●), or stop (■) the class recording.

   **Note:** For your convenience and for integration with third party remote controls, the Tegrity Recorder for PC includes the following keyboard playback control shortcuts:
   - Pause (CTRL+ALT+SHIFT+P)
   - Resume (CTRL+ALT+SHIFT+R)
   - Stop (CTRL+ALT+SHIFT+S)
5. Click ■ to stop the class recording. The *End Recording* dialog box appears.

![End Recording Dialog Box](image)

Figure 8: End Recording Dialog Box

6. Select one of the following options and click **Yes**.

- **Upload (in the background)** — Upload the class recording to the Tegrity server from your computer. Uploading the class recording does not affect the performance of your computer. The Tegrity Recorder closes and the *Tegrity: Recording completed* balloon tip appears.

![Tegrity: Recording completed Balloon Tip](image)

Figure 9: Tegrity: Recording completed Balloon Tip

- **Preview** — Preview your class recording, after which you can choose to **Upload** or **Delete** the class recording. The *Recording successfully created* dialog box appears.

![Recording Successfully Created Dialog Box](image)

Figure 10: Recording Successfully Created Dialog Box

Continue with step 7.

- **Delete** — Delete the class recording. The *Tegrity Recorder* closes.
7. Click Click here to preview. A browser window opens and plays in the window and back the recording.

8. View the class recording (refer to Viewing a Class Recording Online on page 54).

9. When you finish viewing the class recording, close the browser window.

10. Select Upload (in the background) or Delete from the Recording successfully created dialog box.

---

**Tegrity Recorder Instructions for Mac Users**

Tegrity provides easy-to-use setup, installation, and recording options for Mac users.

**Installing the Tegrity Recorder Application on Your Mac**

When you access Tegrity Campus for the first time from your Mac, you must install *Tegrity Recorder*.

To install Tegrity Recorder on your Mac:

1. Log into Tegrity Campus. The **Download Recorder** button appears in the upper left corner of the page.

---

![Figure 11: My Tegrity Page – Download Recorder Option (Mac)](image-url)
2. Click **Download Recorder**. The *Download Mac Recorder* web page appears.

![Figure 12: Download Mac Recorder Page](image)

3. Click **Tegrity Recorder** to download the Tegrity application. The *Downloads* list appears with a message box that enables you to download the Tegrity application.
4. Click **Download**. The *Download Manager* dialog box appears showing the download progress of the Tegrity Recorder.

5. Copy the Tegrity Recorder application to a folder of your choice.

6. Exit your web browser (Safari, Firefox).

7. Run Tegrity Recorder.

8. If the Tegrity Recorder Plugin is not installed on the computer and not all browsers were closed, click **Install Plugin** (shown in the following figure) to install the Plugin.

![Figure 13: Download Tegrity Application (Mac)](image)

![Figure 14: Install Tegrity Plugin (Mac)](image)
Updating the Tegrity Recorder Application on Your Mac

Tegrity automatically notifies you when Tegrity Recorder updates are available and whether an update is critical.

To update the Tegrity Recorder application on your Mac:

1. Login to Tegrity Campus. When an update is available, the Download Recorder button appears on the page.
2. Click Download Recorder. The Download Mac Recorder page appears (Figure 12).
3. If the update is not critical, a Not Now button appears at the end of the list of instructions. Click Not Now to bypass the update. The Download Mac Recorder page closes.
4. Delete previous versions of the Mac recorder.
5. Follow the instructions for downloading the Mac recorder (refer to Tegrity Recorder Instructions for Mac Users on page 16).

Recording Classes on Your Mac

To record and upload classes on your Mac:

1. Start the Tegrity Recorder Application in one of the following ways:
   - Run the Tegrity Recorder Application locally.
   - OR
   - Click Record a Class on the Class Recordings page (Figure 2).
   The Record dialog box appears.

![Figure 15: Record Dialog Box (Mac)](image-url)
2. Select a course from the Course drop-down list. If your course title does not appear in the list, you may still record by selecting **Record for a not listed course** from the Course drop-down list.

3. If you want to give the class session a name, type the session name in the **Title** text box. The default title for a class session is the date and starting time of the recording.

4. To adjust the audio settings for your recording, click **Sound**. The standard Macintosh Sound dialog box appears. Adjust your input volume so that the input level stays near the center of the Input level display.

5. To record an instructor video, check **Use Camera**.

6. To select the video source to be used as instructor video, click **Camera**. The Camera dialog box appears.

![Camera Dialog Box](image)

**Figure 16: Camera Dialog Box (Mac)**

7. From the **Camera** drop-down list, select the camera you would like to use for the instructor video and click **Close**.

**Note:** The camera selected for the instructor video will also be used during the recording for the instructional video.

8. To change your instructor photo, drag the new image into the image frame next to your name.

9. To start recording, do one of the following:
   - Click **Record** in the Record dialog box.
   - OR-
   - Select **File > Record**, as shown in the following figure.
Recording begins and the **Tegrity Recorder Toolbar** appears in the lower right corner of the screen. If you selected to use a camera in the recording, a camera icon will appear in the toolbar.

10. During the recording process, use the Tegrity Recording toolbar buttons to pause ( ), resume ( ), or stop ( ) the class recording.

11. If you are using a camera in the recording, click **Pause** to display the video from the selected camera. While the video from the camera is displayed, the icon **Pause** will appear in the toolbar. Click **Pause** to close the video display.

12. Click **Stop** to stop the class recording. The **End Recording** dialog box appears.

13. Click one of the following:
   - **Don’t Save** – Recording stops and your recording is not saved.
   - **Cancel** – Recording resumes.
   - **Save and Upload** – The recording is saved and uploading begins. The **Uploads** dialog box appears, displaying upload progress. Close the window when the upload is complete.
Uploading an Audio File as a Class

You can upload an Audio File as a class. This is particularly useful when no computer is available to record the class. Record the class on a digital recorder and upload the audio.

To upload an Audio File as a class:

1. Navigate to your Class Recordings page (Figure 2).
2. From the Actions drop-down list, scroll down to Course Actions and select **Upload Audio File as Class**. The Upload File dialog box appears.
3. Click **Select**. A *Choose File* dialog box appears.

4. Browse to the file you want to upload and click **Open**. The file name appears to the left of the *Select* button. The file name serves as the class recording name in the *Class Recordings* page (Figure 2).

**Note:** You can only select an audio file with an *mp3* or *wma* file extension.

5. Click **Upload**. The file is uploaded. A message appears indicating whether the upload was successful.

### Presenting Classes in Real Time with Tegrity Live

Tegrity Campus enables you to present live classes in real time. Students can use real time messaging and Voice over IP (VoIP) to communicate with the instructor or other students during the class.

### Scheduling Live Classes

**To schedule a live class:**

1. Navigate to your *Class Recordings* page (Figure 2).

2. From the *Actions* drop-down list, scroll down to *Course Actions* and select **Schedule Live Class**.

   If you do not have Tegrity Live installed on your computer, the *Install Tegrity Live* dialog box appears (refer to *Installing Tegrity Live* on page 26).
The Schedule a class dialog box appears.

![Schedule a class Dialog Box](image)

3. In the Title field, enter the title of your live class.
4. In the Date and Time fields, enter the date and time of your live class.
5. Check Send email invitations to my students to send an email announcement of the scheduled class to all enrolled students.
6. To invite additional attendees, check Invite by email and enter the email addresses of additional attendees in the textbox. Separate multiple email addresses with spaces.
7. Click OK. The Live Class Scheduled dialog box appears.

![Live Class Scheduled Dialog Box](image)
Adjusting Tegrity Live Settings

If you have a video camera connected to your computer that you use as an instructor video, you may choose to stream video from it to your students during a Tegrity Live session.

To enable streaming instructor video:

1. Schedule a live class (refer to Scheduling Live Classes on page 23).
2. Click Settings. The Settings dialog box appears.

   ![Figure 25: Tegrity Live Settings Dialog Box]

3. Check the Stream live video checkbox.
4. Click OK to apply the settings change. The Schedule a class dialog box appears.

   **Note:** Streaming video in Tegrity Live disables application sharing. In addition, it requires all attending students to have high bandwidth internet connections. For these reasons streaming live video is not recommended. Video is captured, however, for on demand viewing even when it is not streamed to students during the live class.
**Installing Tegrity Live**

You must install *Tegrity Live* in order to conduct live classes. It is recommended that you install Tegrity Live when scheduling a live class. Otherwise, installation will take place when you start your live class.

**To install Tegrity Live:**

1. If you do not have Tegrity Live installed on your computer, the *Install Tegrity Live* dialog box appears.

   [Figure 26: Install Tegrity Live Dialog Box]

   Click **Install**. A software installation dialog box appears. Follow the on-screen instructions.

   **Note:** If you would like to install *Tegrity Live* at a later time, click **Skip**.

2. When the software installation is complete, the *Install Tegrity Live* dialog box reappears, with the **Next** button enabled.
Starting Live Classes

It is recommended that you log into Tegrity Campus at least five minutes before the scheduled time of your live class.

To start a live class:

1. In the Class Recordings page, click the Scheduled Live Classes tab. The Scheduled Live Classes List appears.
2. Click the **Join** button of the scheduled class you would like to start. The *Live Class Lobby* page appears.
In the *Live Class Lobby* page, the list of students who have already joined the class appears. You can chat with these students while waiting for other students to join.

3. When you are ready to begin your class, click **Start Class** in the upper left corner of the page. The *Tegrity Live* application opens.

**Note:** *Tegrity Live* classes are also recorded for later viewing just like regular *Tegrity* recordings. Recorded Live classes will appear in the Course’s Class Recordings List (refer to *Viewing the Class Recordings for a Course* on page 53).
USING THE ADVANCED RECORDING FEATURES

Tegrity advanced recording features enable instructors to:

- Add handwritten annotations to a class recording.
- Record from different video sources during a class session.

Adding Annotations during a Class Recording

You can add annotations during a class recording session to an existing page in your presentation, on any desktop application, or you can add a new page to your presentation and make your annotations on this new page. These annotations are visible both during the recording and during playback. You can add your annotations directly on screen using your mouse or a Tegrity Instructor Pen. For more information on the Tegrity Instructor Pen, refer to Using the Tegrity Instructor Pen on page 32.

To add annotations directly on screen using your mouse:

1. Click on the Tegrity Recording toolbar (Figure 7). The expanded Tegrity Recording toolbar appears in the system tray at the bottom of your screen when recording a class.

   ![Figure 30: Expanded Tegrity Toolbar](image)

2. Click to configure and use annotation tools. The Expanded Tegrity Toolbar displays annotation controls, as shown in the figure below.

   ![Figure 31: Expanded Tegrity Recording Toolbar Displaying Annotation Controls](image)
3. Click any annotation control to display annotation options for that control. The following table describes options for each control on the annotation toolbar.

<table>
<thead>
<tr>
<th>Control with Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Annotation Pen</strong> – Enables you to select what you draw as you move your cursor. The functions from left to right are:</td>
<td></td>
</tr>
<tr>
<td>⬤ <strong>Pen</strong> – Draw free-form as you would with a pen.</td>
<td></td>
</tr>
<tr>
<td>⬤ <strong>Rectangle</strong> – Draw a rectangle.</td>
<td></td>
</tr>
<tr>
<td>⬤ <strong>Ellipse</strong> – Draw an ellipse.</td>
<td></td>
</tr>
<tr>
<td>⬤ <strong>Line</strong> – Draw a line.</td>
<td></td>
</tr>
<tr>
<td><strong>Line Width</strong> – Enables you to select line width.</td>
<td></td>
</tr>
<tr>
<td><strong>Color</strong> – Enables you to select line color.</td>
<td></td>
</tr>
<tr>
<td><strong>Lasso</strong> – Enables you to select one or more annotations that you want to erase by encircling them with a closed loop.</td>
<td></td>
</tr>
<tr>
<td><strong>Eraser</strong> – Erases annotations selected with the Lasso.</td>
<td></td>
</tr>
<tr>
<td><strong>Erase All</strong> – Erases all annotations.</td>
<td></td>
</tr>
</tbody>
</table>

4. If you want to insert a new slide into your presentation for your annotations:

   a. From the expanded Tegrity Recording toolbar, click ![ButtonClick](image). The following page template options appear above the expanded Tegrity Recording toolbar.

   ![Figure 32: Expanded Tegrity Recording Toolbar Displaying Slide Options](image)

   b. Click the type of slide you want to use. The new slide appears on your screen and is available for annotation.
c. After adding a new annotation page to your presentation, the next time you add an annotation page, your most recent annotation page insertion appears as an additional page template (Figure 33). This enables you to return to the last page you inserted and modify its content.

![Figure 33: Expanded Tegrity Recording Toolbar Displaying Inserted Slide](image)

5. Select the drawing option you want and use it to create your annotations.

### Using the Tegrity Instructor Pen

The Tegrity Instructor Pen enables instructors to annotate on regular paper, and have those annotations projected to the class as well as be recorded with Tegrity as an integral part of the class recording.

### Installing Batteries in the Tegrity Pen Reader

To install batteries in the Tegrity Pen Reader:

1. Turn over the Pen Reader and remove the battery compartment cover.

![Figure 34: Pen Reader – Battery Compartment Cover](image)

2. Install two AAA batteries with the poles positioned as shown on the label that is embossed inside the compartment.

3. Replace the battery compartment cover.
Installing Batteries in the Tegrity Instructor Pen

To install batteries in the Tegrity Pen:

1. Remove the battery compartment cover.

2. Install three SR41 batteries with the positive poles facing up.

3. Replace the battery compartment cover.

Note: The lifetime of the three SR41 batteries supplied with the Tegrity Pen may vary and cannot be guaranteed.

Replacing the Ink Cartridge in the Tegrity Instructor Pen

The end of the Pen cap also serves as an ink cartridge extractor. To install the refill, follow these steps.

To replace the ink cartridge in the Tegrity Instructor Pen:

1. Remove the Pen cap.

2. Insert the tip of the pen straight down into the Pen cap extractor and press gently so the extractor grabs the used ink cartridge.

3. Pull out the cartridge (attached to the extractor on the cap).
4. Slide a new ink cartridge into the tip of the Tegrity Pen and press gently to secure it in place.

Preparations for Recording with the Tegrity Instructor Pen

To prepare for recording with the Tegrity Instructor Pen:

1. Clip the Tegrity Pen Reader to the top center of your paper in portrait orientation. The paper must be U.S. Letter size (8.5 x 11 inches). Be sure to slide the top of the paper all the way into the clip on the Tegrity Pen Reader.

2. Connect the USB cable from the Tegrity Pen Reader to a USB port on your PC. The plug that goes into the Pen Reader has a small embossed triangle (an arrow) on one side. That side should face up when plugged into the Pen Reader.

**Note:** Once you begin recording, the “Connected” message is replaced by another, as explained in the following section, Using the Tegrity Instructor Pen During Class.

Using the Tegrity Instructor Pen During Class

To use the Tegrity Pen while recording with Tegrity:

1. Press the power button on the Tegrity Pen Reader.

2. When a blank page appears on your computer screen, begin to write on the paper. You can sketch, write out key phrases, draw diagrams, or simply doodle with the pen. As you proceed, your writing appears on the computer screen. If you have a projector attached to the computer, your writing is projected for the class.
**Note:** The blank page on your computer screen is represented at full length, in portrait mode, by default. That is, the size of the paper is scaled to fit into the space on your screen. One advantage of this orientation is that you can write or draw on almost the entire space of a sheet of paper.

The following figure provides guidelines for using the Instructor Pen successfully.

![Figure 39: Instructor Pen – Connected](image)

3. To begin a new page:
   a. Press the right-hand section of the ring around the OK button on the Pen Reader.
   b. Unclip the Pen Reader.
   c. Turn to a new page.
   d. Reclip the Pen Reader to the top center of the paper.

4. To move back and forth among the pages you create, use the left- and right-hand sections of the ring around the OK button.

![Figure 40: Instructor Pen Reader – Navigation](image)

5. To change the color of ink that appears on the screen, choose a color from the annotations toolbar.

![Figure 41: Annotation Bar for Instructor Pen Ink](image)
The color of the ink on your paper does not change, of course. But your students see the color changes you choose.

6. To stop using the Tegrity Instructor Pen, press the power button on the Pen Reader. The notes page closes on your computer screen, and you return to the application you were using (for example, PowerPoint).

7. To begin using the Tegrity Instructor Pen again, press the power button on the Pen Reader. When you see the note-taking page on your screen, begin writing.

**Note:** Any time you write a note when the Pen Reader is off, a balloon message appears, reminding you to press the power button.

8. When you finish recording your lecture, click the stop icon in the system tray.

---

**Capturing Video from a Video Source**

If you have a document camera, DVD, VCR, or other video source attached to your computer, you can capture live video during your class presentation. To enable you to do this, Tegrity Campus adds a video camera icon ((Collider) to the expanded Tegrity Recording toolbar when one or more video sources is attached to your computer.

![Figure 42: Expanded Tegrity Recording Toolbar with Video Camera Icon](image)

**To capture video during a class recording:**

1. Click in the expanded Tegrity Recording toolbar. Icons appear for each video source. (Figure 43).

![Figure 43: Expanded Tegrity Recording Toolbar with the Video Icons](image)

When a single video camera is attached, only one icon appears.

2. Click the video icon for the desired video source. Video is recorded from the selected source.
3. To return to your desktop, click on the expanded Tegrity Recording toolbar. The monitor icon changes to a video camera icon in the expanded Tegrity Recording toolbar and your desktop appears.
Configuring Course Settings

You can define course settings that apply to all class recordings of a specific course. These settings include:

- **Recording options** – Enable enhanced mode and minute counter, and allow students to record content to the course.
- **Publishing option** – Define when students can review class recordings.
- **Delivery options** – Define what devices students can use to review class recordings.
- **Disable student printing options** – Disable student printing of slides used in class recordings.
- **Enable audio search** – Enable search of class audio content.
- **Links definitions** – Define web links that are shown on screen through an entire class recording.
- **iTunesU option** – Enable students to access class recordings using iTunes.

**Note:** Settings that appear grayed out have been disabled by your administrator and you cannot configure them.
Viewing and Modifying Course Settings

To view and edit your course settings:

1. In the Class Recordings page (Figure 2), from the Actions drop-down list, scroll down to Course Actions and select **Settings**. The Settings page appears.

2. When you finish viewing and updating the Course Settings, click **OK** to save your settings.

   **Note:** You may not be able to change some of the settings if they were locked by your Tegrity administrator. These settings will be grayed out.
Selecting Recording Options

You can select the following recording options (refer to Table 5).

Table 5: Class Recording Options

<table>
<thead>
<tr>
<th>Delivery Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Enable enhanced mode</td>
<td>When checked (default), the playback experience is enhanced as follows:&lt;br&gt;• The instructor video remains available throughout the recording.&lt;br&gt;• All PowerPoint slideshow animations and embedded video are captured.</td>
</tr>
<tr>
<td>☐ Enable minute counter</td>
<td>When checked, displays the current minute during a recording. At the beginning of the recording, the minute counter displays two zeroes in red (00). The minutes advance as the session progresses.&lt;br&gt;The minute counter is visible on screen only while recording. The numbers are not included in the recording and do not appear when reviewing a recording.</td>
</tr>
<tr>
<td>☑ Allow students to record</td>
<td>When checked, allows students to record sessions to be added to your course.</td>
</tr>
</tbody>
</table>

To specify class recording options:

1. Open the Settings page for your course (Figure 45).
2. Select each desired recording option.
3. Click OK to save your settings.

Note: Uploaded student recordings appear under the Student Recordings tab (refer to Viewing Student Recordings on page 62).

Selecting a Publishing Option

You must publish a class recording so that your students can find and review the recording. You can specify that all class recordings be published, or that you want to manually control the publishing of each recording.

To specify publishing of class recordings:

1. Open the Settings page for your course (Figure 45).
2. In the Publishing field, check **Publish classes after upload**. (This option is selected by default.)

3. Click **OK** to save your setting.

**To specify manual publishing of class recordings:**

- Uncheck **Publish classes after upload**. Click OK to save your settings.

**Note:** For details about publishing class recordings manually, refer to *Manually Controlling Publication of Class Recordings* on page 75.

**Note:** When you select **Publish classes after upload**, your selection is not retroactive. Previously uploaded class recordings that have not been published are not automatically published; you must publish them manually.

**To specify automatic publishing of student recordings:**

- In the **Settings** page (Figure 45), verify that **Automatically publish student recordings** is selected. Click **OK** to save your settings.

**Note:** Student recordings are automatically published by default.
Selecting Delivery Options

You can select the following delivery options (refer to Table 6).

Table 6: Class Delivery Options

<table>
<thead>
<tr>
<th>Delivery Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑ Allow students to download classes</td>
<td>When checked (default), students can download class recordings to their computers for viewing when they do not have internet access.</td>
</tr>
<tr>
<td>☑ Enable MP3 Podcast (MP3 player, Linux/Mobile Streaming)</td>
<td>When checked, delivery is available by MP3 podcast, iPod/iTunes enhanced podcasting, video podcasting, and RSS.</td>
</tr>
<tr>
<td>☑ Enable Enhanced Podcast (iPod/iTunes)</td>
<td>When checked, prevents students from printing the slides that were included in your class recordings.</td>
</tr>
<tr>
<td>☐ Enable Enhanced Vodcast / MPEG-4 (iPod/iTunes, Linux/Mobile Streaming)</td>
<td>When checked, enables search of audio content.</td>
</tr>
<tr>
<td>☐ Disable student printing</td>
<td><strong>Warning! This option requires significant processing time. Do not use this option unless truly necessary.</strong></td>
</tr>
<tr>
<td>☐ Enable audio search (read the Help prior to use)</td>
<td></td>
</tr>
</tbody>
</table>

To specify delivery options for class recordings:

1. Open the **Settings** page for your course (Figure 45).
2. Select each desired delivery option.
3. Click **OK** to save your settings.
Assigning an iTunes U Tab for a Course

Many educational institutions use iTunes U, the Apple service aimed at students in universities. Tegrity Campus supports integration with iTunes U, allowing instructors to publish class recordings to iTunes U as enhanced podcasts.

To assign an iTunes U tab for a course:

1. Open the Settings page for your course (Figure 45).
2. Enter the required connection information in the iTunes U Tab ID field. Contact your administrator for further information on the required information.

   Once an iTunes Tab ID is assigned for your course, you can select individual class recordings to be published to iTunes U. For more information, refer to Publishing to iTunes U on page 76.

   **Note:** You may still provide access to podcasts of your courses, even if your institution is not using iTunes U. Refer to Selecting Delivery Options on page 42 for information on publishing your course as a podcast or an enhanced podcast.

Restoring Default Settings

To restore all settings to their original values:

1. Open the Settings page for your course (Figure 45).
2. Click Restore Defaults.
**CONFIGURING THE TEGRITY RECORDER**

When you start the Tegrity Recorder you can choose audio and video options you want to use for your presentation.

**Selecting a Picture**

When playing back a Tegrity class recording there is space in the upper left corner for a picture, such as a picture of the instructor or a school logo. Inserting a picture is optional and appears only when instructor video is not used.

To select a picture:

1. Start the Tegrity Recorder (refer to *Starting Tegrity Recorder* on page 10).
2. Click **Select Picture**. The *Select Picture* dialog box appears.

![Select Picture Dialog Box](image)

3. Browse to the picture you want to display.
4. Click **Select Picture**. The picture appears in the *Tegrity Recorder* window. During playback, the picture appears in the upper left corner of the *Tegrity Player* window.

**To delete a picture:**
1. Start the Tegrity Recorder (refer to *Starting Tegrity Recorder* on page 10).
2. Click **Select Picture**. The *Select Picture* dialog box appears (Figure 46).
3. Click **Delete Picture**. The picture reverts to the default image in the Tegrity Recorder window.

**Using Instructor Video in the Class Recording**

If you have a video camera connected to your computer, you see the following changes in the *Tegrity Recorder* window:

- The Test Audio button changes to Test Video.
- The Instructor Video option appears.

The first time you connect a video camera and start Tegrity Recorder, the Instructor Video is not selected and the video camera is not activated. Subsequently, once you select this option, if the video camera is connected, the Instructor Video option is activated as soon as you start the Tegrity Recorder.

Figure 47: Tegrity Recorder Window (Video)
To use a video camera in your class recording:

- Check the Instructor Video checkbox. The video recording appears in the Tegrity Recorder window and is included in your class recording.

To record your class without using video:

- Uncheck the Instructor Video checkbox. The selected instructor picture appears. To replace this picture (refer to Selecting a Picture on page 44).

**Configuring Recorder Audio and Video Settings**

Tegrity enables you to easily control audio and video settings for your courses. You can:

- Select and test audio settings.
- Select and test video settings.
- Enable Enhanced Recording Mode.

**To view your audio and video settings:**

1. In the Tegrity Recorder window, click **Settings**. The Recorder Settings dialog box appears (Figure 48).
Selecting the Audio Source

To select your audio source:

1. In the **Tegrity Recorder** window, click **Settings**. The **Recorder Settings** dialog box appears (Figure 48).
2. From the **Default audio source** drop-down list, select an audio source.

**Note:** If you do not have a video camera attached to your computer, the video options are unavailable.
Selecting the Video Settings

If you have more than one video source connected to your computer, select the video source you want to use. If you are using several video camera sources, assign an icon to each source to help you distinguish between them.

To select your video settings:

1. In the Tegrity Recorder window, click Settings. The Recorder Settings dialog box appears (Figure 48).
2. In the Video settings area of the Settings dialog box, select the video camera to use from the Camera Usage drop-down list.
3. Click Select Icon to select an icon to help you identify your video camera. A list of icons appears.
4. Click the icon you want to assign to your video camera.
5. By default, the instructor video capture output resolution is the same for all cameras even if you are using a hi-definition camera. If you are using a hi-definition camera, you can define a different resolution for the video capture output resolution. To define a different output resolution for your video camera, select the correct output resolution from the Output resolution drop-down list.
6. Repeat steps 2-5 for each video camera source that you want to use during your class recording.

Selecting a Different Audio Source for Different Video Sources

If one of the video sources connected to the computer is a DVD player or a VHS player, you may want to configure the Tegrity Recorder to capture audio from a different audio source. For example, you may want to capture the audio from the DVD player instead of the microphone.

To select a different audio source for a selected video source:

1. In the Tegrity Recorder window, click Settings. The Recorder Settings dialog box appears (Figure 48).
2. In the Video settings area of the Settings dialog box, select the video camera to use from the Camera Usage drop-down list.
3. Check Switch Audio To.
4. Select the required audio source from the drop-down list.
Testing Your Audio and Video Capabilities

The Tegrity recorder enables you to test audio quality without video or to test audio and video quality together.

Testing Audio Quality

To test audio quality when recording without video:

1. In the Tegrity Recorder window (Figure 47), click Test Audio. A Test Audio dialog box appears.

   ![Test Audio Dialog Box](image)

   Figure 49: Test Audio Dialog Box

2. Click Start Test. The Start Test button changes to Stop Test.

3. In your normal speaking voice, speak into the microphone for a few seconds.

4. Click Stop Test. The Play Test button appears and the Stop Test button changes to Start Test.

5. Click Play Test to listen to the audio that you recorded.

6. Verify that the level and quality of your audio recording are acceptable.

7. If necessary, adjust the recording volume (refer to Adjusting the Recording Audio Level on page 13).

8. If you want to repeat the test, click Start Test again.


Testing Video and Audio Quality

When you record using a video source, you test video and audio quality from a single test dialog box.

**Note:** The following procedure should only be performed by someone who has detailed knowledge of the video camera that is being tested.

To test video and audio quality:

1. In the Tegrity Recorder (Video) window (Figure 47), click **Test Video**.
   
   –OR–

   In the Tegrity Recorder window (Figure 47), click **Settings**. The **Settings** dialog box appears (Figure 45). Click **Test Video**.

   The Test Video dialog box appears.

   ![Test Video Dialog Box](image)

   Figure 50: Test Video Dialog Box

2. Click **Start Test**. The **Start Test** button changes to **Stop Test**.

3. Stand in front of the camera and speak into the microphone for a few seconds in your normal speaking voice.

4. Click **Stop Test**. The **Play Test** button appears and the **Stop Test** button changes to **Start Test**.

5. Click **Play Test** to view the video you recorded. The video playback appears in the Video Camera Playback window.
While the video plays, you can use the control panel at the bottom to pause, play, or stop the video. You can also raise or lower the playback volume.

6. Verify that the audio volume level and quality of your video recording are acceptable. Click close the Video Camera Playback window.

7. If necessary, click Settings to adjust the camera settings and adjust your recording volume (refer to Adjusting the Recording Audio Level on page 13).

8. If you want to repeat the test, click Start Test again.

Enabling Multimedia Room Mode

In smart classrooms or multimedia rooms, Tegrity Recorder can record in a specialized Multimedia Room mode. This mode is designed specifically for integration in such rooms. If you are conducting your classes in such a room and you are familiar with the technology available within these rooms, contact your Tegrity support personnel to enable this mode.

Managing Your Course Uploads

All Tegrity class recordings are automatically uploaded with no additional necessary interaction. However, for your convenience, you can monitor and control the upload process.

To check the status of a class recording upload:

- Right-click the Tegrity Recorder icon and select Check Upload Queue. The Recordings in Upload Queue dialog box appears, displaying the name and upload status of each recording submitted.

Note: Class recordings for which the upload process is complete are not listed.
Recordings in the upload queue can have one of the following statuses:

- **Processing** – Tegrity is preparing the recording for upload.
- **Uploading** – Tegrity has started the upload process. A progress bar indicates the progress of the upload.
- **Waiting** – The upload process has been delayed.

To delay the upload of a class recording:

- Right-click the *Tegrity Recorder* icon and select **Snooze Upload**. The upload is delayed until 1:00 a.m. and the status changes to **Waiting**.

To resume uploading after snooze:

1. Right-click the Tegrity Recorder icon.
2. From the menu that appears, notice that Snooze Upload is checked.
3. Click **Snooze Upload** to uncheck this option. Uploading of all recordings in the queue is resumed.
Accessing Recordings and Additional Content

Tegrity enables you to easily find and view your class recordings. When you view a class, you can quickly navigate through the recording using the Chapters Index or Search feature.

Viewing the Class Recordings for a Course

Tegrity enables you to view the list of class recordings for all your courses.

To view a list of the class recordings available for a course:

- In your Course Management System, click the Tegrity link or button located in your course page.
  - OR -
- From the My Tegrity page (Figure 3) click a course. The Tegrity Class Recordings page (Figure 2) appears with the Classes tab selected and showing a list of the course’s class recordings. For some courses, the following additional tabs are available:
  - Additional Content (refer to Viewing Additional Content on page 61).
  - Student Recordings (refer to Viewing Student Recordings on page 62).
  - Scheduled Live Classes (refer to Viewing Your Scheduled Live Classes List on page 64).

Note: To access the Course Management page, refer to Accessing Tegrity Campus on page 4.

Class recordings that you have not viewed are bolded. The class recording list displays the following information:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Information Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Class</td>
<td>The title of the class.</td>
</tr>
<tr>
<td>Recorded</td>
<td>The date on which the class was recorded.</td>
</tr>
</tbody>
</table>
### Column Name | Information Displayed
--- | ---
Duration | The duration of the class recording (in minutes and seconds).
nock | The download control. Click to download the class recording to your computer.
Status | If there is at least one active bookmark in the recording created by the current user, a ⭐ appears in this column. If the bookmark is inactive, a ◆ appears in this column.

(For more information about bookmarks, refer to Creating Bookmarks in a Recording on page 84.)

Otherwise, if a status exists for this session (e.g., Not Published, Available Soon) then the status appears.

---

**Navigating through your Class Recordings List**

When your class recordings list is too long to be displayed in its entirety on your screen, drag the scroll bar to view additional class recordings.

---

**Viewing a Class Recording Online**

You can view a class recording from the Class Recordings page.

**Tip:** The Latest Classes area in the Class Recordings (Figure 2) or My Tegrity (Figure 3) pages display the names of the last two classes that were uploaded. To view these classes, click the link for the class you want to view.

**To view a class recording online:**

1. From the Class Recordings page (Figure 2), click the course name in which the class recording is located. Thumbnail images of the chapter index entries and the titles of the chapters appear below the class title, as shown in the following figure. The icon to the left of the class title indicates whether the thumbnails are shown (✓) or hidden (✓).
If you stop a recording while it is playing, the next time you access the same recording, a new thumbnail image appears before the other thumbnail images. This new thumbnail image enables you to resume your playback from where you left off during the previous playback session.

**Note:** The *Resume* thumbnail image only appears if you previously viewed this recording and stopped it at some point before the end of the recording.
2. To select a starting point for viewing:
   a. Hover your mouse over the chapter index entries to view enlarged index entries.
   b. Click the first chapter index entry (indicated by a (1) under the thumbnail image) to view the recording from the beginning.

   -OR-

   Click any other index entry to view the recording from that starting point.

   The class recording is played starting from the selected chapter.
An indication in the lower left corner displays the current playback time and the length of the recording (in the format hh:mm:ss/hh:mm:ss). This is followed by an icon which provides an indication of the network connection status.

A problematic playback may indicate a problem with the network connection, such as not enough bandwidth or a disruption in your network connection. Tegrity provides you with a method to help diagnose the problem. Click the network connection status icon to view additional details about the network status. You can click **Test my computer** to obtain additional information about your network connection.
During playback, the following playback controls are available:

<table>
<thead>
<tr>
<th>Tegrity Buttons</th>
<th>Use</th>
</tr>
</thead>
</table>
| ![Pause and Play](image) | **Pause and Play** – These icons alternate depending on your action:  
  - Click ![Pause](image) to pause the class recording. The button changes to a Play button ([Play](image)).  
  - Click ![Play](image) to continue viewing the class recording. The icon changes to a Pause button ([Pause](image)). |
| ![Previous](image) | **Previous** – Click ![Previous](image) to return to the previous chapter (or to the beginning of the class recording). |
| ![Next](image) | **Next** – Click ![Next](image) to advance to the next chapter (or to the end of the class recording). |
| ![Volume](image) | **Volume** – Move the slider to change the volume.  
  - To raise the volume, move the slider to the right.  
  - To lower the volume, move the slider to the left. |
| ![Playing Speed](image) | **Playing Speed** – Move the slider to increase or decrease the speed at which the class recording is played. As you move the slider to the right, the speed advances until it reaches the maximum, twice (2x) the class recording speed. The speed is displayed to the right of the slider. |
| ![Display Chapter Index](image) | **Display Chapter Index** – Click to display the chapter index in the main window. You can use the displayed index entries to move to a different part of the recording. |
| ![Smart Slider](image) | **Smart Slider** – Hover over the slider to see thumbnail images of the corresponding chapter. Drag the slider to jump directly to a specific point. Markers on the slider indicate bookmarks created for the recording (refer to Creating Bookmarks in a Recording on page 84). |
| ![Print](image) | **Print** – Click to print the current Web page. |
| ![Download](image) | **Download** – Click to download the class recording you are currently viewing to your computer. |
| ![View Full Screen](image) | **View Full Screen** – Click to maximize the viewer to fill your screen. |
| ![Help](image) | **Help** – Click to open Tegrity online help or the tutorial. |
Searching Class Recordings

You can search your class recordings for specific content. You can:

- Search all class recordings as well as all additional content you uploaded and all bookmarks to which you have access.
- Search within a single class recording, including all bookmarks to which you have access.

Searching for Specific Content in All Class Recordings

To search for specific content in all class recordings:

1. In the Class Recordings page (Figure 2), type a key word or phrase in the Search field.

   ![Figure 58: Course Management Page Search Field](image)

2. Click Search. Tegrity Campus searches all the class recordings, additional content including additional content you uploaded such as Word, Excel, and PowerPoint documents, and student recordings. It displays the results of the search, as shown in the following figure.

   ![Figure 59: Search Results](image)

3. Click the search result graphic or text to start playing the class recording from the point at which the key word or phrase was found.
Tip: Click the navigation buttons to return to your search results after viewing a class recording that was selected from the Search Results page.

Searching for Specific Content in a Class Recording

To search for content in a class recording during playback:

1. Type a keyword or phrase in the Search field in the upper right corner of the page, as shown in the following figure.

   ![Tegrity Viewer Search Field](image)

   Figure 60: Tegrity Viewer Search Field

   2. Click Search. Search results appear in the main window.

   ![Tegrity Viewer Class Search Results](image)

   Figure 61: Tegrity Viewer Class Search Results

   3. Double-click the required search result in the list to start playing the class recording from the point at which the key word or phrase was found.
Viewing Additional Content

You and your students can view additional content that you have uploaded for your course.

To view additional content for your course:

1. In the Class Recordings page (Figure 2), select the Additional Content tab. A list of related files and/or links appears.

Note: Files appear with a standard file name followed by their file size. Links appear as hyperlinks.

2. To view an external link, click the name of the link. The link opens in a new browser window.

3. To download a file, click the download icon.
Viewing Student Recordings

To view student recordings:

- In the Class Recordings page (Figure 2), select the Student Recordings tab. The Student Recordings page has the same format as the Class Recordings page (Figure 2) with the addition of a column that displays the name of the student who created the recording. For information on viewing student recordings (refer to Viewing a Class Recording Online on page 54).

Making a Student Recording Available to All Students

By default, student recordings are always automatically published. However, this setting can be disabled and then when students upload their recording, it is only available to their instructor and themselves. If the recording is not published, it appears in the Student Recordings page (Figure 63) with the status Not Published. You can publish this recording to make it available to all students. If you publish a student recording, it appears on everyone’s Student Recordings page with the student’s name.

To publish a student recording:

1. In the Class Recordings page (Figure 2), select the Student Recordings tab.
2. Select the student recordings you want to publish.
3. From the Actions drop-down list, under Class Actions select Publish.
**Subscribing to Media Updates**

Tegrity enables you to subscribe to a number of media update services, including:

- Video Podcasts (M4V)
- Enhanced Audio Podcasts
- RSS Feeds
- MP3 Podcasts

**To subscribe to media updates:**

1. Click ![Subscribe](image)
   - OR – Click ![RSS](image)
   - OR – Click ![MP3](image)
   
   The *Subscribe to Podcasts, RSS or MP3 feeds* dialog box appears.

   ![Figure 64: Subscribe to Podcasts, RSS or MP3 feeds Dialog Box](image)

2. Select the course for which you want to subscribe to media updates.
3. Click the media update service to which you want to subscribe.
4. If you select RSS or MP3, follow the on-screen instructions.
5. Click **OK**. You receive a message indicating whether your subscription was successful.
Viewing Your Scheduled Live Classes List

You can view your scheduled live classes.

To view your scheduled live classes list:

- In the Class Recordings page (Figure 2), select the Scheduled Live Classes tab. The Scheduled Live Classes page appears.

Figure 65: Scheduled Live Classes Page
Viewing Class Recordings on a Mobile Phone

To view class recordings on a mobile phone:

1. In the Class Recordings page (Figure 2), click . The Mobile Support dialog box appears.

   ![Figure 66: Mobile Support Dialog Box](image)

2. Select your mobile carrier from the Carrier drop-down list.
3. In the Phone number field, enter your phone number.
4. Click Send. A message appears indicating whether your mobile link was established successfully. Within a few minutes you should receive a text message on your cell phone containing a link to log into Tegrity Campus.

Adding a Tegrity Link to Your Facebook Account

You can add a Tegrity link in your Facebook account, enabling you to access your Tegrity Campus courses from within Facebook.

To add a Tegrity link to your Facebook account:

1. In the Class Recordings page (Figure 2), click . The Subscribe to Facebook dialog box appears.
2. Click Subscribe.

3. If you are not currently logged into Facebook, the Facebook login page appears. Login to Facebook using your Facebook account username and password.

4. Facebook’s Allow Access dialog box appears. Click Allow.

5. Click Bookmark Tegrity Campus to enable future access to Tegrity Campus from within Facebook. The Tegrity Campus application link appears in your Facebook applications list.

6. To access Tegrity Campus from within Facebook, click Applications > Tegrity Campus. The Tegrity Campus Application page opens in Facebook.

7. Click My Tegrity.
MANAGING CLASS RECORDINGS AND ADDITIONAL CONTENT

Tegrity enables you to manage your class recordings after they have been uploaded. You can:

- Copy, move, delete, or rename recordings.
- Perform edits, such as making cuts, changing chapter titles, and adding closed-captions, bookmarks, and annotations.
- Create a CD or DVD of Class Recordings.

Note: You can also perform these tasks on class recordings in an archived course.

Selecting a Class from the Course Management Page

To select a class recording:

1. Click the course name in the My Tegrity page (Figure 3). The Class Recordings page (Figure 2) appears.
2. Each class that appears on your Class Recordings page (Figure 2) has a checkbox beside its name. Select the checkbox next to the required class recording.
Once the class recording is selected, you can perform an action on the class, as required.

**Note:** To select all the class recordings on the page, select the checkbox next to the word *Classes* at the top of the class recordings list.

### Copying a Class Recording

You can copy a class recording from one course to another. This is useful when the same class is relevant for different courses. You can also make a copy of a class recording within the course. This allows you to maintain the original copy of the class recording while editing a session or divide a long recording into several smaller recordings.

**To copy a class recording to another course:**

1. In the *Class Recordings* page (Figure 2), select the checkbox next to the class recording you want to copy (Figure 69).
2. From the *Actions* drop-down list, under *Class Actions* select *Copy*. A dialog box appears.
3. Search for the course to which you want to copy the class recording. Select the course and click *OK*. A copy of the class recording appears in the class list of the course that you selected.
Moving a Class Recording

Moving a class recording deletes it from the class list of one course and adds it to the class list of another course.

To move a class recording to another course:

1. In the Class Recordings page (Figure 2), select the checkbox next to the class recording you want to move (Figure 69).
2. From the Actions drop-down list, under Class Actions select Move. A dialog box appears.
3. Search for the course to which you want to move the class recording. Select the course and click OK. The class recording now appears in the class list of the course that you specified. The class recording is removed from the class list of the original course.

Deleting a Class Recording

To delete a class recording:

1. In the Class Recordings page (Figure 2), select the checkbox next to the class recording you want to delete (Figure 69).
2. From the Actions drop-down list, under Class Actions select Delete. A dialog box appears.
3. Click OK. The selected class recording is deleted.

Renaming a Class Recording

You can rename and assign a new creation date to a class recording.

To rename a class recording:

1. In the Class Recordings page (Figure 2), select the checkbox next to the class recording you want to rename (Figure 69).
2. From the Actions drop-down list, under Class Actions select Rename. A dialog box appears.
3. Type a new title for the class recording.
4. Click in the creation date field and select a new creation date for the class recording.
5. Click OK. The class recording appears with the new title you specified.
Editing a Class Recording

You can edit your class recording using the editing functions from the Actions drop-down list.

To edit a class recording:

1. In the Class Recordings page (Figure 2) select the checkbox next to the class recording you want to edit (Figure 69).
2. From the Actions drop-down list, under Class Actions select Edit. The Tegrity Class Editor appears with the Actions drop-down list in the lower left corner of the window.

Cutting Segments from a Class Recording

Tegrity enables you to delete content from a class recording by cutting segments.

To cut a segment from a class recording:

1. In the Class Recordings page (Figure 2) select the checkbox next to the class recording you want to edit (Figure 69).
2. From the Actions drop-down list, under Class Actions select Edit. The Tegrity Class Editor appears with the Actions drop-down list in the lower left corner of the window.
3. From the *Actions* drop-down list, select **Cut**. The class recording begins to play and the *From* and *To* buttons appear in the lower left corner of the window (Figure 71).

![Figure 71: The Cut Segment Controls](image)

4. Watch the playback of the class recording and when you want to begin deleting content, click **From**. The starting time of the deletion appears in the *From* text box.

5. When you want to stop deleting content, click **To**. The ending time of the deletion appears in the *To* text box.

6. Click **Apply**. The section of the class recording you specified is deleted from the class recording.

### Adding Closed Captions to a Class Recording

You can display closed captions with your class recording. The text keeps pace with the viewer’s progress through the recorded session.

Tegrity Campus supports the use of .txt and .srt closed caption files.

**To add closed captions to a class recording:**

1. Select the class recording for editing (refer to *Editing a Class Recording* on page 70).

2. From the *Actions* drop-down list, select **Add Close Captioning**. The class recording begins to play, displaying the *Add Close Captioning* controls in the lower left corner of the window (Figure 71).

![Figure 72: Add Close Captioning Controls](image)

3. Browse to the desired close caption file and click **Apply**. The closed caption text appears in the upper left corner of the *Class Recording* window during playback (Figure 72).
Editing Chapter Information

You can change a chapter title or add or delete searchable keywords associated with the chapter.

To edit chapter information:
1. Select the class recording for editing (refer to Editing a Class Recording on page 70).
2. From the Actions drop-down list, select Edit Chapter. The Edit Chapter controls appear.
3. Select the chapter you want to edit from the Chapter drop-down list.
4. Click Edit. The Edit Chapter dialog box appears.
5. To change the chapter title, enter the new title in the *New Title* text box.
6. To add one or more keywords, type the keywords in the *Keyword* text box. Separate multiple keywords with a space.
7. To delete an existing keyword, select the keyword and press **Delete** on your keyboard.
8. Click **Apply**. The title and keywords are updated according to your input.

**Adding Video to a Recording**

You can import *asf* format video clips to include in your class recording.

**To add video to a recording:**

1. Select the class recording for which you want to add a video (refer to *Editing a Class Recording* on page 70).
2. From the *Actions* drop-down list, select **Import Video Clip**. The *Import Video* controls appear.
3. Play the recording to locate the point at which you want to insert the video clip and click **At**. The play time of the recording at the time you clicked is inserted as the start time.
4. Click **Select**. A *Choose File* dialog box appears.
5. Browse to the video file you want to insert and click Open. The video clip is inserted at the time you specified and becomes a chapter. The start times of all subsequent chapters are adjusted.

Note: You can only choose a file video clip with an asf file extension.

Adding a Searchable Keyword

To add a searchable keyword for the recording:

1. Select the class recording for which you want to add a searchable keyword (refer to Editing a Class Recording on page 70).

2. From the Actions drop-down list, select Add Searchable keyword. The Add keyword dialog box appears. All defined keywords appear in the dialog box.

3. Add one or more keywords separated by spaces.

4. To delete one or more keywords, select the keywords you want to delete and press Delete on your keyboard.

5. Click OK. Your additions and/or deletions are saved.
Manually Controlling Publication of Class Recordings

By default, class recordings created by instructors are published as soon as they are uploaded. This is controlled by the Publish classes after upload option in the Class Recording Settings page (Figure 45).

If you deactivate the Publish classes after upload setting, you will need to publish each class recording manually. When you publish a class recording manually, you choose when the class recording is published and how long it is available for students to view.

You can also specify a future date for hiding class recordings. Recordings that you have hidden are no longer available to students.

Note: Publishing a class recording at a later date affects only the student view. Class recordings are always visible to you, the instructor, even if they have not been published.

Manually Publish a Class Recording

You can manually control when class recordings are made available to students.

To manually publish a class recording:

1. In the Class Recordings page (Figure 2), from the Actions drop-down list, under Course Actions select Settings. The Settings page appears (Figure 45).
2. Uncheck the Publish classes after upload checkbox.
3. Click OK.
4. In the Class Recordings page, select the checkbox next to the class recording you want to publish. In your Class Recordings page, Not Published appears in the right-hand column for your recording if it has not been published.
5. From the Actions drop-down list, under Class Actions select Publish. The Publish Selected Classes dialog box appears.
6. Select one of the following options:
   
   - **Always** to make the selected class recordings always available to the students.
   
   - **Between** and select the dates during which the selected class recordings should be available to the students.
   
   - **Never** to hide the selected class recording from the students.

7. Click **OK**.

---

**Publishing to iTunes U**

**To publish to iTunes U:**

1. In the Class Recordings page (Figure 2), select the checkbox next to the name of the class recording for which you want to publish to iTunes.

2. From the Actions drop-down list under Class Actions, select **Publish to iTunes U**. The Publish to iTunes U dialog box appears.
Figure 79: Publish to iTunes U Dialog Box

3. Click Yes.

Providing Direct Links to Class Recordings

You can send a class recording link to anyone to whom you want to give access. This might include students not currently enrolled in your class, colleagues, and so on. In addition, you can post direct links to your recordings on your blog, web page, or send by email.

To provide a direct link to a class recording:

1. In the Class Recordings page (Figure 2), select the checkbox next to the name of the class recording for which you want to provide a link.

2. From the Actions drop-down list, under Class Actions select Get Class Link. The Direct Link to Session dialog box appears.
3. If you want to restrict access to individuals who have a valid login ID for your campus systems and are enrolled in this course, check **Require users to login to view the session**.

4. Right-click the link below and select **Copy Shortcut** to copy the link to your clipboard.

5. Paste the link into emails or embed it in a web page to provide access to others.

---

**Posting a Class Recording to the Tegrity Community**

You can post a direct link to class recording to the Tegrity Instructors community forum. You can select to share the recording with other instructors in your institution or all instructors using Tegrity Campus.

**To post a class recording to the community:**

1. In the *Class Recordings* page (Figure 2), select the checkbox next to the name of the class recording for which you want provide a link.

2. From the *Actions* drop-down list, under *Class Actions* select **Post to Community**. The *Post a Class* dialog box appears.
3. To post to the forum for all instructors in your institution, click *Post to the University Instructors Forum*.

4. To post to the general forum for all Tegrity instructors, click *Post to the General Forum for all Tegrity Instructors*.

5. Optionally, enter a description of the class you posted in the *Description* field.

6. Click *Send*. The posting appears in the selected instructor’s forum.

---

**Creating Additional Content**

You can create additional content for a course. Students can view the additional content you provide. This content can be files or links.

**Uploading Files**

You can upload files of any type for you or your students to view (refer to *Viewing Additional Content* on page 61). The files could be PowerPoint presentations, Word or Adobe documents, media files, and so on. Only students registered for your course have access to the uploaded files.

To upload files as additional content for your course:

1. In the *Class Recordings* page (Figure 2), from the *Actions* drop-down list, under *Additional Content* select *Upload File*. The *Upload File* dialog box appears.
2. Click **Upload**. A dialog box appears showing upload process. A popup message informs you when the upload is complete. The file is uploaded and can be selected from a list when the student selects the *Additional Content* tab for your course.

**Note:** Uploaded files larger than 100 MB are rejected.

### Adding External Links

You can add links to additional resources.

**To add external links to additional resources for your course:**

1. In the *Class Recordings* page (Figure 2), from the *Actions* drop-down list, under *Additional Content* select **Add External Link**. The *Add Link* dialog box appears.
2. In the *Title* field, enter a descriptive name for this link.

3. In the *URL* field, enter the correct URL for the link.

4. Click **OK**. The link is added and appears when the *Additional Content* tab for your course is selected.

### Deleting Additional Content

You can delete additional content you have added.

**To delete an additional file or link:**

1. In the *Class Recordings* page (Figure 2), select the *Additional Content* tab.

2. Check the items you want to delete.

3. From the *Actions* drop-down list, under *Class Actions* select **Delete**. A warning message appears, informing you that you are about to delete the item(s).

4. Click **OK**. The selected items are deleted.
Creating a CD or DVD of Class Recordings

To create a CD or DVD of your class recordings:

1. In the Class Recordings page (Figure 2), select the checkbox next to the class recordings you want to record on a CD or DVD (Figure 69).

2. From the Actions drop-down list, under Class Actions select Make DVD Image. The Tegrity DVD Builder dialog box appears.

3. When you are ready to record, click Continue. A progress dialog box appears displaying the status.

4. When the DVD image is created, a dialog box appears with the option to download the zipped file of the DVD image to your computer.
5. Click **Continue** to download the zipped file of the DVD image to your computer. A progress dialog box appears displaying the status of the download. When the download is complete, you can unzip the file and burn its contents to a CD or DVD.
CREATING BOOKMARKS IN A RECORDING

Bookmarks are used to highlight content in a recording. You can use bookmarks in your recording to:

- Indicate information that is unclear for which you want to clarify.
- Emphasize important information to which students should pay extra attention.
- Add additional information, including URLs.

You can create bookmarks at specific points in a recording while the class is being taught or while reviewing a playback of the recording. As the instructor, the bookmarks you create are public by default—available to anyone reviewing the recording. Optionally, you can make the bookmarks private—available only to yourself.

A recording’s bookmarks appear in the lower left pane during playback. Each bookmark is displayed as an icon followed by the timestamp indicating the point in the recording to which the bookmark refers, and followed by a short description (refer to Table 9). Public bookmarks appear on a recording’s timeline during playback (Figure 86).

<table>
<thead>
<tr>
<th>Bookmark</th>
<th>Use it to mark…</th>
</tr>
</thead>
<tbody>
<tr>
<td>? 0:00:10 [Unclear]</td>
<td>Information that is unclear.</td>
</tr>
<tr>
<td>! 0:00:18 [Important]</td>
<td>Information that is important to review later (e.g., for a test or a final project).</td>
</tr>
<tr>
<td>A 0:00:24 [Empty String]</td>
<td>Information for which you can add your own comments or URL.</td>
</tr>
<tr>
<td>⬆ 0:02:44 [Unclear]</td>
<td>Public bookmark created by an instructor.</td>
</tr>
</tbody>
</table>
If you click a bookmark, the playback will continue from the point to which the bookmark refers.

Students can also create bookmarks and they can make their bookmarks public or private. By default, student’s bookmarks are private. However, as an instructor, you can see all student bookmarks, whether they are public or private.

If a bookmark contains a URL, you can click the URL and a new page will open with the content of the URL.

**Creating Bookmarks while Recording a Class**

You can create bookmarks while you are recording a class using your computer, or using your mobile phone.

**Creating Bookmarks Using Your Computer**

To create bookmarks using your computer:

1. While recording your class, login to Tegrity Campus.
2. From the *Quick Links*, click *Bookmarks*.
   
   –OR–
   
   From the menu bar, click *In Class*.

The In Class page appears.
3. To add bookmarks using your computer, click **Add Bookmarks Now.** The **New Bookmark** dialog box appears.

4. Click the type of bookmark you want to create.
   - To create a bookmark of type *unclear*, click ➤ next to Unclear.
   - To create a bookmark of type *important*, click ➤ next to Important!
To create a bookmark of type *comment*, click **Comment**.

A free text field appears.

![Free Text Field](image)

Figure 89: Free Text Field

5. Enter whatever text you want and click **Add**. The bookmark is added to the recording.

6. To view the bookmarks you created for this class, click the **Bookmarks** tab at the bottom of the **New Bookmarks** dialog box (Figure 88).

### Creating Bookmarks Using your Mobile Phone

To create bookmarks using your mobile phone, you must first register your phone. You will receive a text message with a link to the Tegrity bookmarking Web application.

**Note:** You cannot create bookmarks using your mobile phone if you have no reception. If you lose reception during class, you will lose any new bookmarks you created.

**To create bookmarks using your mobile phone:**

1. While recording your class, login to Tegrity Campus.

2. From the **Quick Links**, click **Bookmarks**.

   -OR–

   From the menu bar, click **In Class**.

   The In Class page appears (Figure 87).

3. To register your mobile phone:

   a. Click **Add Bookmarks from your mobile phone**. The **Add Bookmarks from you mobile phone** dialog box appears.
b. Select your Carrier from the Carrier drop-down list and enter your phone number.

c. Click **Send SMS**. You will receive a text message with a link to your personal *Add Bookmarks* page.

4. Save the link to your *Favorite Sites* on your phone so it is easy to add more bookmarks in the future.

5. Follow the link to your personal *Add Bookmarks* screen. The *New Bookmark* screen appears.

6. Tap the type of bookmark you want to create:
   - To create a bookmark of type *unclear*, tap **Unclear**.
   - To create a bookmark of type *important*, tap **Important**.
   - To create a bookmark of type *comment*, tap **Comment**.

   A screen appears of the bookmark type you selected.
7. Type whatever text you want and tap Add. The bookmark is added to the recording.

8. To view the most recent bookmarks you created for this recording, tap Recent Bookmarks.

Creating Bookmarks while Reviewing a Recording

To create a bookmark while reviewing a recording:

1. When you reach a point in the playback where you want to create a bookmark, select the type of bookmark to create from the type drop-down list in the Class Recording Playback window (Figure 55).

2. Optionally, you can add free text in the free text area.

3. Click Add. The bookmark you create appears in the Bookmarks list.
Creating Bookmarks in a Recording

Activating/Deactivating a Bookmark

During playback, you can change the status of a bookmark you created from active to inactive. Active bookmarks are bookmarks that are available for you to review later, and appear in the session time line. Inactive bookmarks are bookmarks that you have already reviewed and you do not want them to appear in the session time line, but still want to retain for future reference.

To activate/deactivate a bookmark:

- During playback, in the Bookmarks list, click the bookmark type icon ( wondered face) to toggle the status (active/inactive). The icon appears grayed out.

Viewing Content Related to a Bookmark

To view content related to a bookmark:

- In the Bookmarks list, click the bookmark whose contents you want to view. The playback continues from the point to which the bookmark refers.
Emailing Bookmarks

To email a bookmark:

1. In the Bookmarks list, point to the bookmark you want to email, and click the email icon that appears.

![Figure 97: Email Bookmark](image)

The Email this Bookmark dialog box appears.

![Figure 98: Email this Bookmark Dialog Box](image)

2. In the To field, enter the email address of the person to whom you want to send the bookmark. Optionally, enter a display name in the Name field.

3. Optionally, in the From field, enter your email address and your display name.

4. Check Send me a copy to send a copy of the email to yourself.

5. Optionally, enter a message in the Personal Message area.

6. Click Send Email.
Deleting Bookmarks

You can only delete bookmarks that you created.

To delete a bookmark:

- In the Bookmarks list, point to the bookmark you want to delete, and click the delete icon that appears.

Figure 99: Delete Bookmark
Generating Reports

Tegrity enables you to produce the following types of reports:

- **Weekly Summary Snapshots** – Show weekly instructor and student activity and compare it to previous weeks in the current term. Drill down from this report to see detailed reports. For more information, refer to Creating a Weekly Summary Snapshot on page 93.

- **Detailed Reports** – Show detailed reports of instructor and student activity for the current week, past week, or the entire term up to the current date. For more information, refer to Creating a Detailed Report on page 95.

- **Custom Analysis** – Show a report organized by course, class, instructor, or viewer. For more information, refer to Creating a Custom Analysis Report on page 96.

- **Outcome Analysis** – Show students’ grades and completion rate in courses that use Tegrity and those that do not. This enables you to evaluate the impact that Tegrity has on student performance in the current term. For more information, refer to Creating an Outcome Analysis Report on page 101.

Creating a Weekly Summary Snapshot

To create a weekly summary snapshot:

1. From the Reports menu, click **Weekly Summary**. The Weekly Summary Snapshot appears.
Figure 100: Weekly Summary Snapshot

**Tip:** You can also access the weekly summary snapshot by clicking **Reports** in the Quick Links area on the My Tegrity or Class Recordings page (Figure 2) and then clicking **Weekly Summary** in the Reports page.

2. Click any of the links to view a detailed report of the selected information.

3. To scroll through the pages of the detailed report:
   - Click the scroll arrows.
   - OR—
   - Enter the page number.

4. Click the rightmost arrow to return to the parent page.

![Scroll Options](image101.png)

Figure 101: Report Scroll Options

5. Select the page size from the drop-down list to change the size of the report table.

![Page Size](image102.png)

Figure 102: Report Page Size Field

6. To search for content within the report, enter a key word or phrase in the **Report Search** field and click **Find** or **Next**.
Creating a Detailed Report

To create a detailed report:

1. Click Reports > Detailed Reports in the upper right corner of any page.
   
   The Detailed Viewing Reports page appears.

   Figure 104: Detailed Viewing Reports

   **Tip:** You can also access the Detailed Viewing Reports page by clicking Reports in the Quick Links area on the My Tegrity or Class Recordings page (Figure 2) and then clicking Detailed Reports in the Reports page.

2. Click the link for the type of report you want to view. The viewing details for the selected time period appear.

   Figure 105: Viewing Sessions Report
3. Scroll through the pages of the report by clicking the scroll arrows or entering the page number, or return to the parent page by clicking the rightmost arrow (Figure 101).

4. Change the size of the report table by selecting the page size from the drop-down list (Figure 102).

5. Search for content within the report by entering a key word or phrase and clicking Find or Next (Figure 103).

**Creating a Custom Analysis Report**

To create a custom analysis report:

1. Click Reports > Custom Analysis in the upper right corner of any page.

2. From the Viewing Report drop-down list, select the type of report to generate. Options include:
   - **Viewing Report:**
     - By course, class, instructor, viewer – Generates a report of the student viewing activity organized by course, class, instructor, and/or viewer (refer to Generating a Student Viewing Report on page 97).
     - By chapter – Generates a report of the number of times each chapter of each of your class recordings has been viewed (refer to Generating a Student Viewing Report by Chapter on page 99).
• **Recording Report** – Generates a report that keeps track of your class recordings (refer to *Generating a Class Recordings Report* on page 100).

• **Downloading Report** – Generates a report of the student download activity (refer to *Downloading a Report* on page 101).

### Generating a Student Viewing Report

The *Student Viewing* report provides you and your school administrators with statistics on student viewing. The information includes:

- The name of your course.
- The viewing duration for all the class recordings in your course.
- The number of times a class recording has been viewed.

**To generate a Student Viewing Report:**

1. From the *Viewing Report* drop-down list, select **By course, class, instructor, viewer**. The *Report Management* page displays the *Student Viewing Report* settings.

   ![Student Viewing Report Settings](image)

   **Figure 107: Student Viewing Report Settings**

2. In the *Grouping* drop-down lists (Figure 108), define the grouping sequence for the report. Starting with *Grouping 1*, select groups for the report.

   ![Report Grouping Drop-down Lists](image)

   **Figure 108: Report Grouping Drop-down Lists**

3. Select any of the filters (Figure 109) to limit your report results.
4. Define the date range for the report:

   - Type dates in the From and To fields in mm/dd/yyyy format.

   - OR -

   - Select the start date in the calendar on the left, and the end date in the calendar on the right.

5. Optionally, from the Time Aggregation drop-down list, select a time period for which you want to refer to compare results. For example, you can select calendar dates that span two years and refer to results for each year, each month for 24 months, or each week for 104 weeks.

   ![Time Aggregation Drop-down List]

**Note:** If you select Week in the Time Aggregation drop-down list, the From and To fields display the week number and its corresponding dates.

![Week Time Aggregation Example]

6. Optionally, click Notes to display viewing data only for students in your classes who use Tegrity Notes.


---

**Figure 109: Report Filter Criteria**

**Figure 110: Report Date Range Calendars**

**Figure 111: Time Aggregation Drop-down List**
Generating a Student Viewing Report by Chapter

The Student Viewing Report by Chapter shows the number of times each chapter of each of your class recordings has been viewed.

To generate a Student Viewing by Chapter report:

1. From the Viewing Report drop-down list, select **By Chapter**. The Report Management page displays the Chapter Viewing Report settings.

2. In the **Course** field, enter the name of your course.

3. In the **Class** field, optionally enter the name of your class recording. If you omit this field, the viewing report lists the chapter index entries for all of the class recordings in the specified course.

4. Click the **From** field to select the earliest viewing date for your report.

5. Click the **To** field to select the latest viewing date for your report.

6. Click **Run Report**. Your results appear at the bottom of the page.
Generating a Class Recordings Report

The *Class Recordings* report displays the classes you have recorded for a given course.

<table>
<thead>
<tr>
<th></th>
<th>Total</th>
<th>Year 2007</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Recording Duration</td>
<td># of Recordings</td>
</tr>
<tr>
<td>Math 101</td>
<td>0:20:25</td>
<td>9</td>
</tr>
<tr>
<td>Mary Figueroa</td>
<td>0:20:25</td>
<td>9</td>
</tr>
</tbody>
</table>

Figure 113: Example of a Class Recordings Report

**To generate a Class Recordings report:**


2. In the *Grouping* drop-down lists, define the grouping for the report. Starting with *Grouping 1*, select groups for sorting the report.

3. From the *Course* and/or *Instructor* fields, select a report filter criteria to limit your report results.

4. Click the *From* field to select the earliest viewing date for your report.

5. Click the *To* field to select the latest viewing date for your report.

6. Optionally, from the *Time Aggregation* drop-down list, select a time period for which you want to refer to comparative results. For example, you can select calendar dates that span two years and refer to results for each year, each month for 24 months, or each week for 104 weeks.

**Note:** If you select *Week* in the *Time Aggregation* drop-down list, the *From* and *To* fields display the week number and its corresponding dates.
7. Optionally, check **Show recordings copied to courses** to include in the results recordings originally recorded to a different course that were later copied or moved to this course.

8. Click **Run Report**. The report is generated and displayed below the report settings.

9. Scroll through the pages of the report by clicking the scroll arrows or entering the page number, or return to the parent page by clicking the rightmost arrow (Figure 101).

10. Change the size of the report table by selecting the page size from the drop-down list (Figure 102).

11. Search for content within the report by entering a key word or phrase and clicking **Find** or **Next**.

### Downloading a Report

When you want to share copies of a report or prepare a presentation, you can download the report information as either an Acrobat (PDF) file or an Excel spreadsheet.

**To download your report as an Excel Spreadsheet or Acrobat (PDF) document:**

1. From the **Class Recordings Report** or **Student Viewing by Chapter Report** or **Student Viewing Report** settings, click **Download Report**.
   - OR-
   
   a. From the **Viewing Report** drop-down list, select **Download Report**.
   
   b. Define the settings as in steps 2-5 of **Generating a Student Viewing Report** on page 97.
   
   c. Click **Download Report**.

   The **Select Report Type** dialog box appears.

2. Select **Download By Excel** or **Download by PDF**.

3. Click **OK**.

### Creating an Outcome Analysis Report

The Outcome Analysis Report shows students’ grades and their completion rate in courses that use Tegrity and those that do not. This enables you to evaluate the impact that Tegrity has on student performance in the current term.

**To generate an outcome analysis:**

1. Click **Reports > Outcome Analysis** in the upper right corner of any page.
Tip: You can also access Outcome Analysis Reports by clicking Reports in the Quick Links area on the My Tegrity or Class Recordings page and then clicking Outcome Analysis in the Reports page.

2. Right-click template and save the template Excel file to your computer.

3. Fill out the downloaded Excel file with the required information for your courses and save the file.

4. Click Browse and select the Excel file prepared in step 3.

5. Click Upload. The Download Outcome Analysis page appears.

   Download Outcome Analysis

   Click Download to download the Outcome Analysis and its supporting data.

   Figure 115: Download Outcome Analysis Page

6. Click Download. The downloaded Excel file contains two worksheets. The first worksheet is a summary score card for the current term. The second worksheet contains the raw data for each course from which the summary score card was produced. You can use this data to conduct additional statistical analysis using Excel and other third party software.
ONLINE COLLABORATION

Tegrity Campus offers online collaboration in the form of an Announcements page, Instructor and Student Forums, and a Community Board. The Announcements page displays news and announcements from both Tegrity and your institution. The Instructor Forums provide you with a common forum for instructors in all universities using Tegrity as well as an instructor forum specific for your institution. The Student Forums provide you with a common forum for students in all universities using Tegrity as well as a student forum specific for your institution. The Community Board displays news about Tegrity.

Viewing Announcements and News

To view announcements and news:

1. In the Quick Links area in the My Tegrity page (Figure 3) or the Class Recordings page (Figure 2), click User Forum. The Community page appears (Figure 116).
2. In the Quick Links area in the Community page, click Announcements.

–OR–

Click Community > Announcements in the upper right corner of any page.

The Announcements page appears (Figure 117).

Figure 116: Community Page
The upper section of the page displays Tegrity news and announcements. The lower section of the page displays your Institution’s news and announcements.

Accessing Forums

As an instructor, you can access instructor and student forums.

To access instructor and student forums:

1. In the Quick Links area in the Community page (Figure 116), click one of the following:
   - **Student Forums**. The Student Forums page appears (Figure 119).
   - **Instructor Forums**. The Instructor Forums page appears (Figure 118).

   –OR–

   Click Community > User Forums in the upper right corner of any page. The Instructor Forums page appears (Figure 118).
In the Instructor/Student Forums page, the first discussion forum is a common forum for instructors/students in all universities using Tegrity. The second forum is a forum specific for your institution. You can view the postings on this site or add a posting of your own.

2. Click Instructor Forums, or Student Forums to the right of the displayed forum to view the other forums page.
Accessing the Community Board

To access the community board:

- In the Quick Links area in the Community page (Figure 116), click Community Board.

  - OR -

Click Community > What's New in the upper right corner of any page.

The Community Board page appears.

Figure 120: Community Board Page
CONTACTING TEGRITY

You can contact Tegrity for technical support or to send a comment.

To contact Tegrity for technical support:

1. Login to Tegrity Campus.
2. Click Help > Get Support in the upper right corner of any page.
   The Get Support page appears. This page contains contact information for your institution’s Tegrity help desk, as well as Tegrity Technical Support.

To send comments to Tegrity Corporation:

- In the Quick Links area on the My Tegrity (Figure 3) or Class Recordings page (Figure 2), click the Let Tegrity Know! link. Your email editor opens with an email composition addressed to Tegrity.

Note: Do not use the Let Tegrity Know! link to submit requests for technical support.